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Welcome to the Vid Grid on-line Help window.
The following Help Topics are available for finding out more about Vid Grid.
Click on any topic below with an underline to go to that topic.

General:
How to Play Vid Grid

Vid Grid Screens:
The Main Screen

The Play Screen
Custom Mode

Scoring:
Understanding Vid Grid Levels
Scoring & Saving the Game

How to Use Vid Grid HELP

Clicking on "How to Use Vid Grid HELP" above brings up a separate Help window that provides
extensive information on how to get the most out of this Help window. Info about using Menu bar
and Button bar commands is also covered.

To return to this window from any Help screen, click on the Contents button above.
To get out of this Help window and get back to the game, select Exit from the File menu.



How to Play Vid Grid

To return to the Help screen you were just in, click on the Back button above.

VID GRID GAME OVERVIEW
As you watch each video, the screen is divided into pieces that are all mixed up. You have to
unscramble each video while it's playing and before the music ends.

Vid Grid consists of five levels: Level 1 being the easiest, up through Level 5, the most difficult.
While you can choose the videos in any order you like, the puzzle configurations are preset by Vid
Grid and get progressively more difficult as you play. You must solve all the video puzzles in a level
before advancing to the next level. Within a level, you may replay any video to try to beat your last
best time. You are not penalized for repeating a video. You score points each time you solve a video
-- the harder the puzzle configuration, the more points you get. In addition, you get bonus points
based on how quickly you solve the video. The bonus points are not added to your score until the
end of each level. Try to get the highest score by solving the most puzzles in the shortest times.

There is also a Custom Mode for playing a single video at a time. Custom Mode allows you to
select which video to play and to select the desired puzzle configuration. Custom Mode allows two
or more players to compete at solving the same video puzzle. No points are scored in Custom
Mode; the object is simply to get the best time.

VID GRID BASIC INSTRUCTIONS

IMPORTANT: To get optimal performance while playing Vid Grid, we strongly recommend that you
do not run any other programs or applications in the background. Please close all other
applications. If you experience any difficulties running Vid Grid, exit Windows, then load Windows
again (type WIN at the C:\ prompt) and run Vid Grid before opening any other applications. You may
have to remove icons from your Start-Up group in the Windows Program Manager. Also, to view the
videos at their largest video size, set you monitor resolution to 640 x 480 pixels.

Step One. Select Player. If the player's name in the lower left corner of the screen is your name,
you can skip this step. If not, click on the Change Player button located in the lower left corner of
the Main Screen to select or add your name.

IMPORTANT: To save games, scores and best times, the correct player's name must be selected
before playing.

Step Two. Select a Video. Click on one of the "stills" in the Main Screen to "play" that video. These
"stills" are actually "buttons" that you use to select a video. This will take you from the Main Screen
to the Play Screen. Note: The "stills" are pictures taken from the videos and are "scrambled" until
the respective video is "solved".

IMPORTANT: You can click on a "still" using the right mouse button to see information about the
video and the recording artist.

Step Three. Play the Video. When you are ready, click the "Play" button in the upper right hand
corner of the Play Screen. The video and the timer will start. Use your mouse to unscramble the
pieces. See the section entitled "Using the Mouse to Unscramble the Pieces" that follows this
section for further instructions. If the Video finishes before you do, the timer will read "Time's Up!". If
you solve the Video, the timer will display your time and a green neon border around the Video
Window will light.

IMPORTANT: You can continue watching the video or get on with the game by either clicking Reset
or Main.



You now have a number of choices:

You can try to solve the same video again: Click Reset and then Click Play when you are
ready.

You can play a different video: Click Main, then go back to Step Two of these instructions.

You can change players: Click Main, then click Change Player.

You can try Custom Mode: Click Main, then click Custom Mode.

You can exit Vid Grid: Click Quit.

If you want to "give up" in the middle of playing a video, click on either Reset to start over or Solve
(so you can at least watch the rest of the video). In either case, you get no points (or penalties).

That's it. All the rest are just details you can pick up as you play Vid Grid. Please refer to the
following more detailed instructions if you have any questions or run into any problems.

USING THE MOUSE TO UNSCRAMBLE THE PIECES
There are three basic mouse moves:

Drag and Drop the Pieces. You can move a piece to any position. Move the mouse to position
the arrow cursor over a piece. Use the left mouse button to click and drag the selected piece to a
new location and release the left mouse button. You don't have drag the piece into an exact
position, as it will automatically snap to the closet grid position. This move works in any puzzle
configuration involving either Drag and Drop or Perfection puzzle movements (see the section
below "How Videos are Scrambled" for more details about puzzle configurations).

Slide the Pieces. You can move a piece to an adjacent empty piece. Use the left mouse button to
click on a piece that is next to an empty piece. The piece will "slide" into the empty piece's position.
This move works in any puzzle configuration involving either Slider or Random Corners puzzle
movements.

Flip the Pieces. You can flip an individual piece from top to bottom. Use the right mouse button to
click on a piece and "flip" it. This move works in any puzzle configuration involving Inverted Pieces.

HOW THE VIDEOS ARE SCRAMBLED

Vid Grid puzzles start easy, with nine right-side-up pieces that can be moved by simply dragging
them around the Video Window. However, as you progress through the game, you will encounter
more difficult puzzles which are the result of changing three sets of puzzle attributes: Puzzle Size,
Puzzle Movement and Video Orientation.

PUZZLE SIZE
There are seven puzzle sizes:

3x3/4x4/5x5/6x6. Videos can be scrambled into nine pieces (3 pieces by 3 pieces), 16 pieces
(4x4), 25 pieces (5x5), or 36 pieces (6x6).

3-4/3-4-5/3-4-5-6. There are also "progressive" 3-4 puzzles (which starts with 9 pieces that, when
initially solved, re-scrambles into 16 pieces); "progressive" 3-4-5 (9 to 16 to 25) and "progressive" 3-
4-5-6 (9 to 16 to 25 to 36).



PUZZLE MOVEMENT
There are four types of puzzle movement:

Drag and Drop. You click on a piece with the mouse and drag it anywhere in the Video Window
and drop it there. The piece that was in that spot will swap with the moved piece. Drag and Drop
mode allows you to swap the positions of two pieces.

Slider. You can only move a piece to the blank piece next to it. Simply click on a piece next to the
blank piece. The piece will switch with the blank piece. You can only move a piece that is next to the
blank piece. You can only move one position up, down, left or right. Diagonal moves can't happen.
In Slider, the piece that belongs in the bottom right hand corner is always the blank piece.

Perfection. This is the same as Drag and Drop except that the video re-scrambles if a piece is
dropped in the wrong position. However, if either of the swapped pieces ends up in its correct
position, the video will not re-scramble. Also, if you drag a piece, but return it to the position from
which you took it before dropping it anywhere, this is not considered a move and the video will not
re-scramble.

Random Corners. This is the same as Slider, except the blank piece is not necessarily from the
bottom, right corner: it may be from any corner.

VIDEO ORIENTATION
There are three types of video orientation:

Normal. The video plays in the normal fashion (right side up).

Upside Down. The video plays upside down (and so all the pieces are upside down). You cannot
flip the pieces.

Inverted Pieces. The video plays right side up, but some of the individual pieces may be upside
down. You can flip any piece using the right mouse button.

For more Help with Vid Grid, click on the Contents button above. This will take you to the Contents
window which lists additional topics you can select for more information.

To get out of this Help window and get back to the game, select Exit from the File menu.



The Main Screen

Vid Grid's Main Screen is the "home base" that you use to select videos, change, add or delete
players, choose Custom Mode and more.

Click on any function below - outlined in green - to learn more about that function.

Vid'Grid: L-ﬂm’EJ"I

D-Dﬂ

Asro=mith Fnrnﬁr{;ﬂ minl

Sour R War Hafan
Player; Fiok f

For more Help with Vid Grid, click on the Contents button above. This will take you to the Contents
window which lists additional topics you can select for more information.

To get out of this Help window and get back to the game, select Exit from the File menu.



Video Buttons

Here you will see the video buttons in their scrambled state as miniaturized still
pictures of the real videos. To choose a video, click once on the still picture
from that video with the mouse (these miniature video pictures are actually
"video buttons" that you use to select a video). The still pictures are scrambled
to indicate that the particular video has not been solved by the current player in
the current level. The manner in which the still pictures are scrambled indicates
the puzzle configuration for the upcoming round.

Clicking on a video button with the left mouse button takes the game out of the
Main Screen and into the Play Screen. The Play Screen is where you attempt
to solve the video puzzle in the shortest time for points. The puzzle type is
preset by Vid Grid.

Clicking on a video button with the right mouse button will display a window
with artist, song and video credits.

For complete details on how to use the Play Screen, see Chapter 3 in the Vid
Grid Owner's Manual.

Click once with the mouse button or press a key to continue...



Screen Title

The name of the artist and the song title are displayed at the top of this screen.

Click once with the mouse button or press a key to continue...



Main Screen Title

The Main Screen title display shows the current Level of the game for the
current Player.

Click once with the mouse button or press a key to continue...



Custom Mode button

This takes Vid Grid out of the Main Screen and into Custom Mode. In Custom
Mode, you select which video puzzle you want to solve and you customize the
puzzle configuration (puzzle size, puzzle movement and video orientation).

For more information, see the Help window for Custom Mode.

For complete details on how to use Custom Mode, see Chapter 4 in the Vid
Grid Owner's Manual.

Click once with the mouse button or press a key to continue...



Change Player button

Vid Grid allows you to compete against other players. Use this button to open
the Change Player dialog box.The Change Player dialog box adds new players
to Vid Grid and allows you to delete players as needed. The name of the
Current Player is displayed in the lower left-hand corner of the screen. Vid Grid
will store up to 10 player's names and scores.

Click once with the mouse button or press a key to continue...



Help button

Clicking this the Help button on any screen opens the Help window. The Help
window is context sensitive.If you click the Help button from the Main Screen,
help for the Main Screen will be displayed.If you click the Help button from the
Play Screen, help for the Play Screen will be displayed.

Once the Help window is open, you can scroll through the window and view all
the Help information for Vid Grid. The Help window will provide you with
general and specific Help on playing Vid Grid. Point to any function outlined in
green and click once with the mouse.

A pop-up window will appear that will give you information about that function.
To get out of the pop-up window, click again with the mouse or press a key on
your computer's keyboard.

Click once with the mouse button or press a key to continue...



Quit button

Clicking this button quits Vid Grid and returns you to Program Manager. The
status of your game, including your times and score will be saved
automatically. If you quit Vid Grid and come back to it later, all of your hard
work will be saved and the game will start where you left off.

Click once with the mouse button or press a key to continue...



Player display

The name of the current player is displayed in the lower left-hand corner of the
Main Screen. All scoring -- solved puzzles, base points, bonus points and best
times -- will be saved with this player's name. To change to a different player,
allow new players to sign-on, or to delete players from the game, click on the
Change Player button. Anytime a new or different player is selected, that
player's name will be displayed here.

Click once with the mouse button or press a key to continue...



Score display

The accumulated score for the Current Player is displayed in the lower right-
hand corner of the Main Screen. The displayed score = the current running
total of all earned base points + earned bonus points for previously completed
Levels. Remember that bonus points are not added to your score until the
current Level has been completed.

Click once with the mouse button or press a key to continue...



The Play Screen

Clicking a video button on the Main Screen brings you to the Play Screen where you "play" the
videos.

Click on any function below - outlined in green - to learn more about that function.
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For more Help with Vid Grid, click on the Contents button above. This will take you to the Contents
window which lists additional topics you can select for more information.

To get out of this Help window and get back to the game, select Exit from the File menu.



Video Puzzle window

The large window in the center of the screen is where the videos play.
When videos are not playing, this window displays the Vid Grid logo.
For a complete guide to playing Vid Grid, click on "How to Play Vid Grid" below:

Click here > How to Play Vid Grid

Click once with the mouse button or press a key to continue...



Solve button

Clicking on this button instantly solves the puzzle. The video will continue
playing until it reaches the end or the Stop button is pressed. We put this
function in so that you can at least watch the video even if you are having
trouble solving the puzzle. Clicking this button does not earn you a solved
puzzle credit or any points!

Click once with the mouse button or press a key to continue...



Reset button

Clicking this button re-scrambles the video and starts it again from the
beginning. You can use Reset to give you a fresh start for any solved or
partially solved video puzzle. Reset is useful if you want to try to beat your last
time for a better score.

Click once with the mouse button or press a key to continue...



Timer window

The small window above the video window is a clock timer that displays the
elapsed time of the video -- in minutes and seconds -- and records the time it
takes a player to solve the selected video. The Timer window starts at "0:00"
and counts until the video ends. The numbers will be red until you click Play.
During Play, the numbers will be green. If you solve the puzzle, the timer will
freeze at the time you solved it and the numbers will be red again. If the video
ends before it is solved, this window will display "Time's Up". Clicking Reset or
Solvewill reset the Timer.

Click once with the mouse button or press a key to continue...



Play/Pause/Resume/Stop button

Clicking this multi-state button repeatedly loops through several functions --
depending on the present state of the video puzzle.

Click Play when you are ready to start playing a video. The video will play and
the timer will start. After you click Play, this button turns into a Pause button.

Clicking Pause allows you to stop the video anytime during playback. Pause
also stops the timer -- you won't be penalized for pausing the puzzle, but the
video screen will display the Vid Grid logo. You cannot move pieces unless the
video is playing. After you click Pause, this button turns into a Resume button.

Clicking Resume starts playback from the point where the video was stopped.
This allows you to use the same button to pause and resume the video as often
as you need.

The Stop function of this button only appears when the puzzle is solved. If you
solve it manually or use the Solve button, the Pause function turns into a Stop
function. After you click Stop, this button turns into a Play button and will loop
between Play and Stop to allow you to view the video you have solved.

Click once with the mouse button or press a key to continue...



Main button

To select another video, change players or select the Custom Mode, you must
return to the Main Screen by clicking this button.

Click once with the mouse button or press a key to continue...



PUZZLE TYPE mini-window

The mini-window just to the left of the video screen displays the current
puzzle's pre-set combinations of puzzle size (3x3, 4x4, 5x5, 6x6, 3-4, 3-4-5 and
3-4-5-6), puzzle movement (Drag and Drop, Slider, Perfection or Random
Corners) and video orientation (Normal, Upside Down or Inverted Pieces).

Click once with the mouse button or press a key to continue...



TIME TO BEAT mini-window

Vid Grid allows players to re-play solved videos to get a better time. The Time
to Beat mini-window records the current player's best time during the current
game for the selected video. This window will be blank until the current player
solves the selected video. Players may re-select a particular video at any time
during a Level. If the player's time improves, the player's new time displays in
the Time To Beat window and the bonus score will be increased upon
completion of the Level. There is no penalty for getting a worse time (bonus
points are awarded on the basis of the player's best time during the current
game).

Note: Players may not replay videos from a prior Level.

Click once with the mouse button or press a key to continue...



Volume control

You can adjust the audio volume by clicking on the volume arrows beneath the
video window. The < button reduces the volume and the > button increases it.
The green and yellow lights will show you the relative volume level. The last
light segment is a red light that indicates maximum volume.

Click once with the mouse button or press a key to continue...



Custom Mode

Clicking the Custom Mode button on the Main screen puts Vid Grid into Custom Mode. Custom
Mode is where you play against other players or the clock for Best Times. Custom Mode is a play
mode in Vid Grid that allows you to determine the puzzle configuration.

Click on any function below - outlined in green - to learn more about that function.
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For more Help with Vid Grid, click on the Contents button above. This will take you to the Contents
window which lists additional topics you can select for more information.

To get out of this Help window and get back to the game, select Exit from the File menu.



Select Video button

Clicking this button calls up a dialog box that allows you to select a video from
a list of all the videos. Click the name of the video you want to play and click
the OK button to load it.

After the video has been selected, use the next three buttons to set up the
puzzle. Clicking these "multi-state" buttons repeatedly loops forward through all
available choices. Holding down the shift key on the keyboard while clicking on
the buttons with the mouse reverses through the order.

Click once with the mouse button or press a key to continue...



3x3/4x4/5x5/6x6/3-4/3-4-5/3-4-5-6 button

Clicking this "multi-state" button repeatedly loops through the seven puzzle
sizes (3x3, 4x4, 5x5, 6x6) plus three "progressive" puzzle sizes (3-4, 3-4-5, 3-
4-5-6). Each time it is clicked, it will change to the next higher puzzle size.

3x3/4x4/5x5/6x6: Videos can be scrambled into nine pieces (3 pieces by 3
pieces), 16 pieces (4x4), 25 pieces (5x5), or 36 pieces (6x6).

3-4/3-4-5/3-4-5-6: There are also "progressive" 3-4 puzzles (which starts with 9

pieces that, when initially solved, re-scrambles into 16 pieces); "progressive" 3-
4-5 (9 to 16 to 25) and "progressive" 3-4-5-6 (9 to 16 to 25 to 36).

Click once with the mouse button or press a key to continue...



Drag-Drop/Slider/Perfection/Random Corners button

Clicking this "multi-state" button repeatedly loops through the four puzzle movements: Drag and
Drop, Slider, Perfection and Random Corners.

Drag and Drop: You click on a piece with the mouse and drag it anywhere in the Video Window
and drop it there. The piece that was in that spot will swap with the moved piece. Drag and
Drop mode allows you to swap the positions of two pieces.

Slider: You can only move a piece to the blank piece next to it. Simply click on a piece next to
the blank piece. The piece will switch with the blank piece. You can only move one position up,
down, left or right. Diagonal moves can't happen. In Slider, the piece that belongs in the bottom
right hand corner is always the blank piece.

Perfection: This is the same as Drag and Drop except that the video re-scrambles if a piece is
dropped in the wrong position. However, if either of the swapped pieces ends up in its correct
position, the video will not re-scramble. Also, if you drag a piece, but return it to the position
from which you took it before dropping it anywhere, this is not considered a move and the video
will not re-scramble.

Random Corners: This is the same as Slider, except the blank piece is not necessarily from
the bottom, right corner: it may be from any corner.

Click once with the mouse button or press a key to continue...



Normal/Upside-Down/inverted Pieces button

Clicking this "multi-state" button repeatedly loops through the three puzzle
orientations: Normal, Upside-Down and Inverted Pieces.

Normal: All pieces are scrambled right-side up.
Upside-Down: The entire puzzle is scrambled with all its pieces upside down.

Inverted Pieces: Vid Grid selects only a few pieces at random to be upside
down (you have to figure out which ones they are). In either case, a piece that
is upside down can be turned right side up by clicking on it with the right mouse
button.

Click once with the mouse button or press a key to continue...



Best Times button

Clicking on this button displays a list of the 10 best times (with the names of the
players) for the currently selected video in the currently selected puzzle
configuration. The Best Times list includes all such best times from both

Custom Mode and Levels Play.

Click once with the mouse button or press a key to continue...



Understanding Vid Grid Levels

Vid Grid consists of five levels: Level 1 being the easiest, up through Level 5, the most difficult.
While you can choose the videos in any order you like, the puzzle configurations are preset by Vid
Grid and get progressively more difficult as you play. You must solve all the video puzzles in a Level
before advancing to the next Level. Within a Level, you may replay any video to try to beat your last
best time. You are not penalized for repeating a video. You score points each time you solve a video
-- the harder the puzzle configuration, the more points you get. In addition, you get bonus points
based on how quickly you solve the video. The bonus points are not added to your score until the
end of each Level. Try to get the highest score by solving the most puzzles in the shortest times.

Completing a Level. If you successfully solve all puzzles in a Level, Vid Grid will immediately
switch back to the Main Screen as soon as the last video is solved. Each video button will "unwrap"
and show you your Bonus points scored for that puzzle. While all of this is happening, watch the
score total display in the lower right-hand corner of the screen: your Bonus points will be added to
your Base points as the videos unwrap and the total "rolls up". As with solving an individual video,
this running total is automatically saved to the current player's file on your hard drive. At the end of
the score "roll up", Vid Grid displays the next Level screen.

For more Help with Vid Grid, click on the Contents button above. This will take you to the Contents
window which lists additional topics you can select for more information.

To get out of this Help window and get back to the game, select Exit from the File menu.



Scoring & Saving the Game

Best Times. Clicking on this button displays a list of the 10 best times (with the names of the
players) for the currently selected video in the currently selected puzzle configuration. The Best
Times list includes all such best times from both Custom Mode and Levels Play.

Saving the Game. Vid Grid automatically saves solved video puzzles and earned points to a file on
your hard drive. When the first player signs on, Vid Grid creates a file with that player's name and
saves related information to that file whenever a puzzle is solved (which video, solve time, Level,
round and points scored). This way, if you quit Vid Grid and come back to it later, all of your hard
work will be saved and the game will pick up where you left off.

Base Points and Bonus Points. For each signed-on player, points will be awarded and displayed
for each solved puzzle. The number of Base points awarded increases after each video is solved.
Bonus points are also awarded based on how quickly the video is solved, but these points are not
added to the player's score until the Level is completed. The number of bonus points per second
increases after each Level is completed.

For more Help with Vid Grid, click on the Contents button above. This will take you to the Contents
window which lists additional topics you can select for more information.

To get out of this Help window and get back to the game, select Exit from the File menu.



How to Use Vid Grid HELP

Clicking this the Help button on any screen opens the Help window. The Help window is context
sensitive. If you click the Help button from the Main Screen, help for the Main Screen will be
displayed. If you click the Help button from the Play Screen, help for the Play Screen will be
displayed.

Once the Help window is open, you can scroll through the window and view all the Help information
for Vid Grid. The Help window will provide you with general and specific Help on playing Vid Grid.
Point to any function outlined in green and click once with the mouse.

A pop-up window will appear that will give you information about that function. To get out of the pop-
up window, click again with the mouse or press a key on your computer keyboard.

A comprehensive help screen that describes how to use this Help window can be called up by
clicking on the Help menu above and selecting the

How to Use Help item. How to Use Help lists numerous topics that you can select that will teach
you specific Help window techniques including Help Basics.

Below the Menu bar is a Button bar that will assist you in getting around Vid Grid Help quickly. To
learn how these buttons work, click on the Help menu above and select the How to Use Help item.
At the very bottom of the window is a topic called Help Buttons that tells you how to use Vid Grid
Help command buttons.






